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How to Use SPSS®

A Step-by-Step Guide to
Analysis and Interpretation

Addendum for Versions 9.0 and 10.0

How to Use SPSS: A Step-by-Step Guide to Analysis and Interpretation was designed for use
with SPSS Version 8.0. Since then, Versions 9.0 and 10.0 have been released. Although Version
9.0 differs in a number of ways from Version 8.0, only three cosmetic changes will affect users
of the book. These changes from Version 8.0 to 9.0 are described below.

CHANGE #1. The Statistics menu has been renamed Analyze.

CHANGE #2. The Summarize menu (that was under Statistics) has been renamed Descriptive
Statistics.

’énalyze Graphs Utilities Window Help
Reports » biesl sl | _

CHANGE #3. The submenus under the General A Descriptive Statistics . Frequencies...
Linear Model command have been renamed. GLM - Compare Means b Descriptives...
General Factorial has been renamed Univariate. - GeneralLinearModel »  Explore..
GLM - Multivariate has been renamed simply i §°"e'a"? »  Lrosstabs..
Multivariate. Finally, GLM - Repeated Measures has ﬁegfess'm X
been renamed simply Repeated Measures. 1 'aoag;:;a' :
F@_s_nalyze Graphs Utiities Window Help § .g_:;eﬁedqctlon :
~ Reports L ‘ - )
Dasaioie ssiies » IS 9|9 il
Gompagidess o b e ‘Multile Response ~ »
General Linear Model » Univariate... — ;
Correlate A Multivariate. .. '
Reagression -} Repeated Measures...
I&iil:;a' :  Vaiiance Components...
Data Reduction 4
Scale »
Nonparametric Tests »
Survival ok
~ Multiple Response ~ »

Note: If you are using Version 10.0, first read the material for Version 9.0 on
this page. Then read the material for Version 10.0 on the inside back cover of
this book.



Introduction

The SPSS statistical package is designed to perform a wide range of statistical
procedures. Like any other powerful computer program, there are certain conventions and
techniques that must be mastered in order to use the program efficiently and to obtain
correct answers consistently. By providing detailed step-by-step guidance illustrated with
worked-out examples, this book will help you achieve such mastery.

In addition to showing you how to enter data and obtain results, this book shows you
how to select appropriate statistics and state the results in a form that is suitable for use in a
research report in the social or behavioral sciences. For example, the section on the
independent ¢ test shows how to state (i.c., phrase) the results of both a significant and an
insignificant test.

Audience

This book assumes only a basic understanding of statistics. Thus, it is ideal as a
supplement to a traditional introductory statistics textbook. It can also be used as a
statistics refresher manual in a research methods course. Finally, students can use it as a
desk reference guide in a variety of workplace settings after they graduate from college.

SPSS is an incredibly powerful program, and this text does not attempt to be a
comprehensive user’s manual. Instead, it targets the procedures normally covered in
introductory courses in statistics and research methods.

Organization

The book is organized into eight chapters. The first two chapters deal with the basic
mechanics of using the SPSS program. Each of the remaining chapters focuses on a
particular class of statistics.

Each chapter contains several short sections. For the most part, these sections are
self-contained. However, it is expected that students will master the SPSS basics in
Chapters 1 and 2 before attempting to learn the skills in the rest of the book. Except for the
skills in the first two chapters, the book can be used in a nonlinear manner. Thus, an
instructor can assign the first two chapters early in a course, and then assign other sections
in whatever order is appropriate.

Appendix A contains a “decision tree” that helps in the selection of appropriate
inferential statistics for various research designs. Appendix B contains data sets that are
needed for the Practice Exercises that are interspersed throughout this book. The glossary
in Appendix C provides definitions of most of the statistical terms used in this book.
Because it is assumed that it is being used in conjunction with a main statistics textbook,
the glossary definitions are brief and designed to serve only as reminders. Finally,
Appendix D provides the sample data files that are used throughout this book.

SPSS Versions

There are numerous variations and versions of the SPSS statistical package. This
guide was written for use with the 8.0 version of SPSS for Windows. It can work easily
with earlier versions, especially Versions 7.0 and 7.5. However, there are substantial
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differences in how the output appears between Version 6.1 and later versions. These
differences are noted in this book.

The menu bars shown in the illustrations are ones that appear when the Base,
Professional, and Advanced modules (the most common modules) of the program have
been installed. If your menu bars look different or if you cannot locate a menu item for a
command presented in this book, it may be that your institution supports different modules.
For instance, some colleges use only the Base module, but the Reliability procedure is
available only with the Professional module and the repeated measures ANOV A procedure
is available only with the Advanced module. Check with your instructor for additional
guidance.

Some institutions purchase site licenses from SPSS to make the software available
free of charge to their faculty and, sometimes, their students. If your institution has not
purchased a site license, you should still be able to purchase the student version of the
software in your campus bookstore at a discounted price for the educational community.
Either of these will be a fully functional version of the software intended for your personal
use.

Conventions

The following conventions have been used throughout this book.
e Items presented in bold are defined or explained in the Glossary in Appendix C.
e [tems in italics are either buttons or menus from the SPSS program or statistical
symbols.
e Items in ALL CAPITAL LETTERS are either acronyms or the names of variables in
the SPSS data file.

Practice Exercises

Practice exercises are included for each skill presented. In addition, the skills
acquired in this text can be used in doing the practice exercises in other statistics texts or
workbooks. One text that would work well in this capacity is Real Data: A Statistics
Workbook."
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Addendum for Version 10.0

This book was originally written for use with Version 8.0 of SPSS. Since then, Versions 9.0 and
10.0 have been released. If you are using Version 10.0, first read the addendum on the inside
front cover of this book, which applies to Versions 9.0 and 10.0.

Version 10.0 has a number of new features. However, most of the changes do not affect the
accuracy of this textbook. The purpose of this addendum material is to describe those changes
that are relevant to this textbook so that users of Version 10.0 can use the How to Use SPSS text.
Note: All the changes listed for Version 9.0 (on the inside front cover of this book) continue to
apply to Version 10.0.

= i
The blggest difference between Version 10.0 and previous ﬂ_f\n:ta View !( 3—ar|ah|e\new 2[

versions is the new data editor. There are two primary
ways that this change affects users of this text:

CHANGE #1. The data window has been changed so that there is a Data View and a Variable
View available. The Data View is the same as previous versions. However, the Variable View
provides an easier way to examine how your variables are defined.

CHANGE #2. Variables must now be defined using the Variable View screen. Instead of a dialog
box for each variable, a single matrix represents all variables in the file. To make a change, click
in the appropriate area. In addition, Define Variable is no longer available on the Data menu, and
the Variable View window must be used to define new variables.
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To define the variable type, labels, value labels, etc., the user now enters the value directly in the
matrix.
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Chapter 1
Getting Started

Section 1.1 Starting SPSS

Starting SPSS will differ slightly depending on the exact configuration of the

machine on which it is installed. On most Windows 95 and Windows 98 computers, you
can start SPSS by first clicking on Start, then clicking on Programs, then on SPSS. On
many installations, there will be an SPSS icon on the desktop that you can double-click to
start the program.
SPSS for Windows When SPSS is started, you may be
o : g | presented with the dialog box to the left, depending
on the options your system administrator selected
for your version of the program. If you have the
box, click Type in data and OK, which will present
a blank data window.'

If you were not presented with the dialog
box to the left, SPSS should open automatically
with a blank data window.

The data window and the output window
provide the basic interface for SPSS. A blank data
window is shown below.

Section 1.2 Entering Data

One of the keys to success with
SPSS is knowing how it stores and uses
your data. To illustrate the basics of data
entry with SPSS, we will use example
1.2.1. -

Example 1.2.1

A survey was given to several students in four different classes (Tues/Thurs
momnings, Tues/Thurs afternoons, Mon/Wed/Fri mornings, Mon/Wed/Fri
afternoons). The students were asked whether or not they were “morning people” and
whether or not they worked. This survey also asked their final grade in the class (out
of 100). The response sheets from two students are presented as follows:

! Items that can be looked up in the glossary are presented in bold.
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Response Sheet 1

ID: 4593

Day of class: _____ _MWF _ X TR

Class time: __ Moming __ X Afternoon

Are you a morning person? Yes _ X No

Final grade in class: 85%

Do you work outside of school? __ Full-time _____ Part-time
X _No

Response Sheet 2

ID: 1901 4

Day of class: _X_ MWF __TR

Class time: _ X Moming ______Afternoon

Are you a morning person? X Yes _ No

Final grade in class: 83%

Do you work outside of school? __ Full-time __X_ Part-time

Our goal is to enter the data from the two students into SPSS for use in future
analyses. The first step is to determine the variables that need to be entered. Any
information that can vary among participants is a variable that needs to be considered.
Example 1.2.2 lists the variables we will use.

Example 1.2.2

ID#

Day of class

Time of class

Morning person

Final grade

Whether or not the student works outside of school

In the SPSS data window, columns represent variables and rows represent subjects.
Therefore, we will be creating a data file with six columns (variables) and two rows
(students/participants).

Section 1.3 Defining Variables

Before we can enter any data, we must first enter into SPSS some basic information
about each variable. For instance, each variable must first be given a name that:
e begins with a letter;
e does not contain a space; and
e is eight characters or fewer in length.
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Thus, the variable name “Q7” would be acceptable, while the variable name “7Q”
would not be. Similarly, the variable name “PRE_TEST” is acceptable, but the variable
| = Untitled - SPSS Data Edito B Jll name “PRE TEST” is not. Capitalization does

| sform not matter, but variable names are capitalized
in this text to make it clear when we are
referring to a variable name.

To define a variable, click on Data
then click on Define Variable. This will bring
up the Define Variable dialog box shown
below. Enter the variable name in the blank
near the top (“id” in the example).

From the Define Variable dialog box,
SPSS allows you to enter variable labels by
clicking on the Labels button. Variable labels
allow you to associate a description with each
variable. These descriptions can describe the
variables themselves or the values of the
variables. For most procedures, SPSS requires
numerical values. Thus, for data such as the
day of the class (e.g.,, Mon/Wed/Fri and
Tues/Thurs) we need to first code the values as
numbers. For example, we can assign the number 1 to Mon/Wed/Fri and the number 2 to
Tues/Thurs. To help us keep track of the numbers we have assigned to the values, we can
click on the Value Label command.

When you enter a value label, you must click
Add after each entry. That will move the associated
value and label into the bottom section of the
window. When all labels have been added, click on
Continue to return to the Define Variable window.

Define Labels
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New with version 8.0 is the ability to indicate the measurement scale on which the
variable is measured. You can select Nominal, Ordinal, or Scale. In SPSS, a scale variable
is an interval or ratio-scaled variable. You need to select the appropriate measurement
scale in the Measurement section of the define variable dialog box. Note that this feature
applies only to some chart functions.

In addition to naming and labeling the variable, you have the option of defining the
variable type. To do so, simply click on the Type button (see dialog box to the left). This
will bring up the Define Variable Type dialog box shown below. Using this dialog box you

can tell SPSS what kind of data you will be
Variable ]| entering. The default value is a numeric field
Ee i — that is eight digits wide with two decimal
places displayed. If your data are more than
eight digits to the left of the decimal place,
they will be displayed in scientific notation
(e.g., the number 2,000,000,000 will be
displayed as 2.00E+09). SPSS maintains
accuracy beyond two decimal places, but all
output will be rounded to two decimal places
unless otherwise indicated in the Decimal
Places blank.

Define Vanable Type: id

SPSS accepts a variety of data types.
To learn more about each variable type, you can right-click (click the right mouse button)
with the pointer over the variable type. This general procedure (right-clicking over part of
the active window) works to get help with most SPSS functions and screens.

In our example, we will be using numeric variables, so you should now click
Continue.

Practice Exercise

Create a data file for the two sample
students and six variables presented in
Example 1.2.1 above. Name your variables:
ID, DAY, TIME, MORNING, GRADE,
and WORK. You should code DAY as 1 =
Mon/Wed/Fri, 2 = Tues/Thurs. Code TIME
as 1 = morning, 2 = afternoon. Code

= pal 15 g ' MORNING as 0 = No, 1 = Yes. Code
[ Vabee o g vl at ot o, —L WORK as 0 =No, 1 = Part-Time, 2 = Full-

calculations. They can contain any characters up lomm . .
s S vl _— Time. Be sure you enter variable labels for

your different values.
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4593.00 200 2.00 .00 85.00

1
2 1901.00 1.00 1.00 1.00 83.00
3

. f 4593.00 [ Tues/Thurs Afternoon No 85.00

No

1901.00 | Mon/Wed/Fr Morning Yes 83.00

Part-Time

The two windows above represent two views of the same
data. To toggle between the two views, you can click Value Labels
under the View menu. You can also click the Value Labels icon on

the toolbar (second from right in the windows above).

Section 1.4 Loading and Saving Data Files

Be sure you enter
the correct measurement
scale type for each.

When done, you
should have a data
window  that looks
something  like  the
window on the upper
left. Notice that SPSS
puts the variable names
as column labels, and
the cells contain the data
as entered. This same
Data Window can be
changed to look
something like the lower
window to the left
instead. Note that in this
case the data cells
display the variable
labels that correspond to
each value entered.

2 Unulled SPSS Da(aEdl!m

Once you have entered your data, you will need to save it for later use, so that you

can retrieve it when needed.

Loading and saving SPSS data files
works in the same way as most Windows-based
software. Under the FILE menu, there are OPEN
and SAVE commands. SPSS data files have a
SAV extension (the extension is. the last three
letters of the file name; this tells Windows that it
is an SPSS data file).

Save Your Data
When you save your data file (by

Save Data As

clicking File then clicking Save, or by clicking

on the disk icon), pay special attention to where you save it. Most systems default to the
location <c:\program files\spss>. You will probably want to save your data on a floppy so
that you can take the file with you, in which case you would select the location <a:\>.
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Load Your Data

When you load your data (by clicking
File then clicking Open, or by clicking the

Coronaiy artety data sav

open file folder icon), you get a similar al Employee data sav
: Fat surlactant sav

window. This window lists all files with the
.SAV extension. If you have trouble locating
your saved file, make sure you are looking in
the right directory.

Practice Exercise

To be sure that you have mastered
saving and opening data files, name your sample data file “sample” and save it on a floppy
disk. Once saved, SPSS will display the name of the file - o
at the top of the data window. | E=) sample - SPSS Data Editor

After you have saved your data, exit SPSS (by
clicking on File then on Exif). Restart SPSS and load
your data.

Section 1.5 Running Your First Analysis

Any time you open a data window, you can run any of the analyses available. To
get started, let’s calculate the students’ average grade. (With only two students, you can
easily check your answer by hand, but imagine a data file with 10,000 student records.)

The majority of the =) sample - SPSS Data Editor
available statistical tests are . Da
under the Statistics menu.
This menu displays all the
options available for your
version of the SPSS pro-
gram. Other versions may
have slightly different sets of
options.

To calculate a mean (average) we
are asking the computer to summarize our
data set. Therefore, the command is run by
clicking Statistics, then Summarize, then
Descriptives.

This brings up the Descriptives
dialog box shown on the next page. Note
that the left side of the box contains a list

=] of all of the variables in our data file. On
the nght 1s an area labeled Variables where we can select the variables we would like to
use in the analysis.
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In version 8.0, the
Descriptives dialog box lists the
variable labels (and names),
along with an icon indicating the || &5 of Class [day]
variable type. Earlier versions list | | Time of Class [time]
just the variable names. | ® Are you a marning persc|

We want to compute the |®oade ,
mean for the variable called | |® D°YouWokOusidec
GRADE. Thus, we need to select
the variable name in the left
window (by clicking on it). To
transfer it to the right window,
click on the arrow between the two windows. Note that double-clicking on the variable
name will also transfer the variable to the right window, and this arrow can be used to
transfer variables in either directions.

+ Descriptives

When we click on the OK
button, the analysis will be
conducted, and we will be ready
to examine our output.

' Descriptives

| ®id
| ® Day of Class [day]

@ Time of Class [time]

| #) Are you a moring perst
. |® Do You'Work Outside ¢

Section 1.6 Examining and Printing OQutput Files

After performing an analysis, your output is placed in the output window, and the
output window becomes the active window. If this is the first analysis you have conducted
since starting SPSS, then a new output window will be created. If you have run previous
analyses and saved them, your output is added to the end of your previous output.

To switch back and forth between the data
window and the output window, select the
appropriate window using the Window menu bar.

The output window is split into two
sections. The left section is an outline of the output
(SPSS refers to this as the outline view). The right
section is the output itself.
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e — -
= {&] SPSS Output
=--{&] Descriptives

(=] Title -
i Nobss = Descriptives
‘(8 Descriptive Ste|
Descriptive Statistics
Std.
N Minimum | Maximum Mean Deviation
GRADE 2 83.00 85.00 84.0000 1.4142
valid N bia:s
(listwise) 2

»

Fd 2 g

The section on the left of the output window provides an outline of the entire output
window. All of the analyses are listed in the order in which they were conducted. Note that
this outline can be used to quickly locate a section of the output. Simply click on the
section you would like to see, and the right window will jump to the appropriate place.

Clicking on a statistical procedure also selects all of the output for that command.
By pressing the delete key, that output can be deleted from the output window. This is a
quick way to be sure that your output window contains only the output you want. Output
can also be selected and pasted into a word processor by clicking Edit then Copy to copy
the output. You can then switch to your word processor and click £dif then Paste.

To print your output, simply click File then Print or click on the printer icon on the
toolbar. You will have the option of printing all of your output, or just the currently
selected section. Be careful when printing! Each time you run a command, the output is
added to the end of your previous output. Thus, you could be printing a very large output
file containing information you may not want or need.

One way to ensure that your output window contains only the results of the current
command is to create a new output window just before running the command. To do this,
click File then New then Quiput. All your subsequent commands will go into your new
output window.

Practice Exercise

Load the sample data file you created earlier (SAMPLE.SAV). Run the
Descriptives command for the variable GRADE and print out the output. Your output
should look like the example above. Next, select the data window and print it.



